This database glossary is designed to accompany MIS Cases: Decision Making With Application Software, Second Edition, published by Prentice Hall. When preparing an MIS Cases: Decision Making with Application Software, Second Edition case, several database skills are necessary. Each case’s skills check feature identifies the major skills that are required to complete the case. Before preparing the case, you should use the skills check feature to help identify which skills you should review.

This database glossary provides a brief explanation and review of the skills utilized in MIS Cases: Decision Making with Application Software, Second Edition. This glossary does not provide detailed explanations for the skills. If you need a detailed explanation on how to use a particular skill, you should use your system’s online help feature to learn more about the skill. Your system’s online help feature is an excellent way to quickly learn about the skill, as well as obtain a detailed explanation on how to use the skill in a database application.

To read a brief explanation for one of the database skills mentioned in MIS Cases: Decision Making with Application Software, Second Edition, please click its hyperlink.
# Database Skills List

<table>
<thead>
<tr>
<th>Advanced Report Design</th>
<th>Subform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Function</td>
<td>Switchboard</td>
</tr>
<tr>
<td>Analyze It with MS Excel</td>
<td>Tab Control</td>
</tr>
<tr>
<td>AutoFilter (Spreadsheet Skill)</td>
<td>Table Design</td>
</tr>
<tr>
<td>AutoLookup Query</td>
<td>Update Query</td>
</tr>
<tr>
<td>Calculated Control</td>
<td></td>
</tr>
<tr>
<td>Calculated Field</td>
<td></td>
</tr>
<tr>
<td>Chart (Spreadsheet)</td>
<td></td>
</tr>
<tr>
<td>Chart Wizard</td>
<td></td>
</tr>
<tr>
<td>Combo Box</td>
<td></td>
</tr>
<tr>
<td>Command Button Wizard</td>
<td></td>
</tr>
<tr>
<td>Crosstab Query</td>
<td></td>
</tr>
<tr>
<td>Data Access Page</td>
<td></td>
</tr>
<tr>
<td>Filter By Form</td>
<td></td>
</tr>
<tr>
<td>Find Unmatched Query Wizard</td>
<td></td>
</tr>
<tr>
<td>Form Design</td>
<td></td>
</tr>
<tr>
<td>Form Wizard</td>
<td></td>
</tr>
<tr>
<td>IIF Function</td>
<td></td>
</tr>
<tr>
<td>Label Wizard</td>
<td></td>
</tr>
<tr>
<td>Lookup Wizard</td>
<td></td>
</tr>
<tr>
<td>Macros</td>
<td></td>
</tr>
<tr>
<td>Parameter Query</td>
<td></td>
</tr>
<tr>
<td>Relationship</td>
<td></td>
</tr>
<tr>
<td>Report Design</td>
<td></td>
</tr>
<tr>
<td>Report Wizard</td>
<td></td>
</tr>
<tr>
<td>Select Query</td>
<td></td>
</tr>
</tbody>
</table>
Database Skills Definitions

**Advanced Report Design:** As this term is used in *MIS Cases: Decision Making with Application Software, Second Edition*, advanced report design means using advanced formatting options to customize a report, rather than relying solely on a Report Wizard to generate the report. When custom designing a report, you have many advanced formatting options available to you, such as the ability to include report, group, and page headers and footers; subtotals and totals; graphics, and the ability to force page breaks. Keep in mind that you can adjust the properties for the entire report, its individual sections, and the controls appearing on the report. ([Return to Skills List](#))

To create a custom report, you can:

1. From the Database window, click the Reports button on the Objects bar in the Database window.

2. Click the New button on the Database Window toolbar.

3. In the New Report dialog box, select Design View, click the drop-down arrow, select the table or query on which to base the report, and then click the OK button. Figure 1 shows the New Report dialog box. (If you select the Report Wizard option, the Report Wizard will ask you a series of questions about your report, and then prepare the report based on your specifications. You can then modify the report in Design View.)

4. The Report Design View window opens. At this point you can drag and drop field names from the field list to the report's design grid. Figure 2 shows the Report Design View after fields have been added to the report.
Advanced Report Example: Assume you want a custom report based on the tblStudent table and that you want the report to appear similar to Figure 3.

To prepare this report, you can:

1. Click the Reports button located on the Objects bar in the Database window.

2. Click the New button located on the Database Window toolbar.

3. In the New Report dialog box, select the Design View option. Select the tblStudent table from the list of available tables and queries box. See Figure 1.

4. At this point, you should see the Report Design View window. Figure 2 shows the Report Design View window after fields have been added to the report. (The
Toolbox toolbar can be activated by clicking the Toolbox button located on the Report Design toolbar. Likewise, if the Report Header section is missing, you can select the Report Header/Footer option from the View menu.)

5. To place an unbound control on the report, such as a report title, you can:

   a. Click the Label button on the Toolbox toolbar.

   b. On the report design grid, position your mouse pointer where you want the control to begin, and then drag until the control is the size that you want. Keep in mind that you can always resize the control.

   c. Click inside the control and enter the text.

   d. Select the control and then set its format properties. For instance, you can click the Center button located on the Formatting toolbar to center the text. You can also change the font color, as well as bold the text. Figure 2 shows the report header “Student Applicant List” centered and bold with a font size of 18.

   e. To include a bound control on your report, drag and drop the field name from the Field List box to the location on the report where you want the control located. At this point, you can set the control's properties, as well as resize the control. In the detail section shown in Figure 2, the LastName, FirstName, MajorCode, and PhoneNumber controls are examples of bound controls. In the Page Header section, the Last Name, First Name, Major Code, and Phone Number controls are examples of unbound controls. Although not shown in Figure 2, calculated controls can be placed on a report.

   f. To preview the report, you can click the View button located on the Report Design toolbar. Figure 3 shows how Figure 2's design appears in Print Preview.
Figure 3: Print Preview of the Student Applicant List Report

**Aggregate Function:** An aggregate function performs a calculation on a group of records. Microsoft Access provides several aggregate functions, including COUNT, SUM, AVG, MIN, and MAX. ([Return to Skills List](#))

**Aggregate Function Example:** Assume that the dean needs a count for the number of student worker positions within the college. Figure 4 shows how the COUNT function can be used in a query. Figure 5 shows the query results.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Major Code</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant</td>
<td>Mitchell</td>
<td>44</td>
<td>555-1255</td>
</tr>
<tr>
<td>Sasser</td>
<td>Lexina</td>
<td>45</td>
<td>555-6456</td>
</tr>
<tr>
<td>Rother</td>
<td>Elwood</td>
<td>45</td>
<td>555-6577</td>
</tr>
<tr>
<td>Chen</td>
<td>Shibo</td>
<td>42</td>
<td>555-4789</td>
</tr>
<tr>
<td>Elotnani</td>
<td>Damir</td>
<td>46</td>
<td>555-3812</td>
</tr>
<tr>
<td>Schoenhals</td>
<td>Elijah</td>
<td>46</td>
<td>555-6058</td>
</tr>
<tr>
<td>Erbost</td>
<td>Troy</td>
<td>44</td>
<td>555-1300</td>
</tr>
<tr>
<td>Ottinger</td>
<td>Clarissa</td>
<td>46</td>
<td>555-9351</td>
</tr>
<tr>
<td>Dlocovichk</td>
<td>Edith</td>
<td>40</td>
<td>555-0202</td>
</tr>
</tbody>
</table>
Analyze It with Microsoft Excel: The Analyze It with Microsoft Excel feature enables you to export a table or query results to Microsoft Excel. (Return to Skills List)

To export data, you can:

1. Select the data that you want exported. (Note: The table or query does not need to be opened. You can select the name of the table or query in the Database window.)

2. From the Tools menu located on the Menu bar, select the Office Links option; select the Analyze It with Microsoft Office Excel option. See Figure 6.
AutoFilter Command: AutoFilter is a Microsoft Excel command that allows you to select and display records from an Excel list that meet certain criteria. Records that do not meet the criteria are temporarily hidden from view. (Return to Skills List)

Once you have exported your data to Microsoft Excel, you can:

1. Place your cell pointer anywhere in the Excel list. (Note: You should assign your Excel list a range name, such as database.)

2. From the Data menu located on the Worksheet Menu Bar, select the Filter option, then the AutoFilter command. At this point, the field names located in the top row of the list now have drop-down arrows beside their names. The drop-down arrows allow you to specify the criteria to use when filtering the records. Figure 7 shows the drop-down arrows that have been added to the Excel List.

AutoFilter Example: As an example, assume you only want to see the information systems faculty. This request requires you to first click the drop-down arrow beside the Department field name. A drop-down list will appear. The drop-down list shows each unique value that appears in the Department column. Since you want to view the information system faculty, you would select the information systems criterion. Figure 8 shows the results for this example.
AutoLookup Query: An AutoLookup query works with tables that have a one-to-many relationship. The AutoLookup query uses the join field from the table on the many side of the relationship to lookup and automatically provide data from the table on the one-side of the relationship. The AutoLookup query is especially useful when building main forms with subforms. The AutoLookup query requires that certain conditions be met. You should use your system's online help feature to learn more about the AutoLookup query. (Return to Skills List)

AutoLookup Query Example: Assume the college dean asks you to design a form that captures data about available positions by department. At the heart of this request is an AutoLookup query. Figure 9 shows the design view for the qryPositionsByDepartment query. Notice that the tables have a one-to-many relationship. Also, notice that the DCode field in the query design grid is from the tblOpening table, not from the tblDepartment table. After saving this query, you can use the Form Wizard to build a form that will allow the dean to enter and view data for each available position by department. Figure 10 shows a sample form based on the qryPositionsByDepartment query.
Calculated Control: A calculated control displays the results of an expression. An expression may include operators, object names, functions, literal values, and constants. At this point, you should use your system's online help feature to learn more about calculated controls.

To include a calculated control on a form or a report, you can:

1. While in design view, click the Text Box button on the Toolbox toolbar.
2. Position the control on the form or report.

3. Click inside the control, and type the expression.

**Calculated Field:** A calculated field is used in a query. The calculated field displays the results of a computation, often involving another field or fields. Since a calculated field's values may change, a calculated field is not stored in a table. The calculated field's values are updated each time the query is run, so the calculated field will display accurate data. When using a calculated field, you should precede the expression with a name for the calculated field, followed by a colon. Figure 11 shows the design view for a query that includes calculated fields. Figure 12 shows the query results. (Return to Skills List)

To include a calculated field in a query, you can:

1. While in the query's design view, click in an empty field located in the design grid.

2. Type a name for the calculated field followed by a colon. Next, type the expression.

**Calculated Field Example:** Assume your college has 10 available student worker positions. The pay for each position is based on its classification and the number of hours available. Your college dean needs to know how much money to allocate for each position type. Further assume that each position is for a 15-week period. To provide the dean with this information, you can design a select query that includes calculated fields. See Figure 11.

![Figure 11: Query Design Window with Calculated Field](Screenshots © Microsoft Corporation. All rights reserved. Copyright © 2005 by Prentice-Hall, Inc., All rights reserved.)
Figure 12: Query Results with Calculated Field

<table>
<thead>
<tr>
<th>Position</th>
<th>Position Count</th>
<th>Wage</th>
<th>Total Available Hours</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>H4</td>
<td>2</td>
<td>$9.50</td>
<td>40</td>
<td>$5,700.00</td>
</tr>
<tr>
<td>G4</td>
<td>1</td>
<td>$9.75</td>
<td>40</td>
<td>$5,950.00</td>
</tr>
<tr>
<td>S1</td>
<td>3</td>
<td>$3.00</td>
<td>30</td>
<td>$3,600.00</td>
</tr>
<tr>
<td>S2</td>
<td>1</td>
<td>$3.50</td>
<td>15</td>
<td>$1,912.50</td>
</tr>
<tr>
<td>S3</td>
<td>3</td>
<td>$3.75</td>
<td>60</td>
<td>$7,875.00</td>
</tr>
</tbody>
</table>

Chart: A chart is a graphical representation of selected data contained in a table, query, or spreadsheet. In MIS Cases: Decision Making With Application Software, Second Edition, you are asked to prepare charts with Microsoft Access and Microsoft Excel. Several methods are available for chart preparation. (Return to Skills List)

To create a chart using Microsoft Excel, perform the following steps:

1. Export the data to Microsoft Excel.
2. Once you have exported the data to Microsoft Excel, select the data that you want represented in the chart.
3. Click the Chart Wizard button on the Standard toolbar.
4. Provide answers to the Chart Wizard's questions. The Chart Wizard asks you to specify the chart type, data range, various chart options, and chart placement.

Chart Wizard: The Chart Wizard is one of several report wizards available in Microsoft Access. The Chart Wizard asks you a series of questions, and then prepares a chart for you based on your answers. To learn more about the Chart Wizard, you should use your system's online help feature. (Return to Skills List)

To activate the Chart Wizard, you can:

1. Click the Reports button located on the Objects bar in the Database window.
2. Click the New Button located on the Database Window toolbar. The New Report dialog box now appears. See Figure 13.
3. Select the Chart Wizard option. Select the table or query on which to base the chart. The Chart Wizard asks questions about which fields you want in the chart, chart type, chart layout, and chart title.
4. At this point, use your system's online help feature to learn more about how to modify a chart.
Figure 13: New Report Dialog Box

**Combo Box:** An end user uses a combo box to select a value from a list. The user clicks the arrow beside the combo box, and then makes a selection from the list of values. In Figure 14, DCode and Assigned Student are examples of combo boxes. The Assigned Student combo box is open, and shows the list of available values. Several methods are available for including a combo box on a form. (Return to Skills List)

To place a combo box on a form, you can:

1. While in design view, click the combo box button located on the Toolbox toolbar.

2. On the form's layout grid, select the location where you want the combo box located; drag to size the box. The Combo Box Wizard dialog box now appears.

3. Answer the Combo Box Wizard's questions. These questions ask you to specify how you want the combo box to obtain its values, which table or query provides the values for the combo box, which fields you want included in your combo box, sort order, whether or not to hide the key column, what to do with the selected value, and a name for the combo box.
Command Button Wizard: The Command Button Wizard enables you to easily add a command button to your form. The newly added command button can be assigned a macro, and when the button is clicked, the macro executes. A command button example is provided below. (Return to Skills List)

To add a command button to your form, you can:

1. In the form's design view, click the Command Button on the Toolbox toolbar.

2. Position your mouse pointer on the form's design grid and then drag to indicate the size of the button.

3. Next, answer the Command Button Wizard's questions. Based on your answers, the Command Button Wizard designs a button for the form. The Command Button Wizard asks you what actions should occur when the button is pressed, whether you want text or a picture to appear on the button, and what name you want for the button.
Crosstab Query: A Crosstab query applies an aggregate function to a group of records and displays the results in a spreadsheet-type format. Figure 15 shows the results of a Crosstab query, and Figure 16 shows the design view for the query. You can create a Crosstab query in design view or you can use the Crosstab Query Wizard. When creating a Crosstab query, you must identify at least three fields in the design grid. One field serves as the row heading; a second field serves as the column heading, and the third field contains the data values that you want correlated. In Figures 15 and 16, the PositionType field serves as the column heading and supplies the data values for the Crosstab query. (Return to Skills List)

To create the Crosstab query in design view, you can:

1. Click the Queries button on the Objects bar located in the Database window.
2. Select the Create query in Design view shortcut.
3. In the Show Table dialog box, select either the table or query on which you wish to base the Crosstab query. See Figure 17.
4. From the Query menu located on the Menu bar, select the Crosstab Query option. See Figure 18.
5. Add the field that will serve as the Crosstab query's row heading to the design grid. In Figure 16, the field is DName. In the Crosstab row, select Row Heading from the drop-down list.
6. Add the field that will serve as the Crosstab query's column heading to the design grid. In Figure 16, the field is PositionType. In the Crosstab row, select Column Heading from the drop-down list.
7. Add the field that contains the data values that you want summarized. In the Figure 16, the field is PositionType. In the Crosstab row, select Value from the drop-down list. In the Total row, select the function that you want applied to the values. In Figure 16, the Count function is selected.
8. Run the query.

Crosstab Query Example: Assume the college dean wants to view the number and type of available student positions for each department. Figures 15 and 16 show how a Crosstab query can satisfy this information request.

<table>
<thead>
<tr>
<th>DName</th>
<th>G3</th>
<th>G4</th>
<th>S1</th>
<th>S2</th>
<th>S3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Finance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Information</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Systems</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marketing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

Figure 15: Crosstab Query Results
Figure 16: Design View for Crosstab Query

Figure 17: Show Table Dialog Box
Data Access Page: A data access page is a Web page that links to a Microsoft Access database. The data access page is accessible via a Web browser and allows the user to view data at varying levels of detail. Depending on how the data access page is designed, the user may be able to update the data in the database. A data access page can be created either in design view or by using the Page Wizard. At this point, you should use your system's online help feature to learn more about data access pages. Figure 19 shows an example of a data access page. (Return to Skills List)
**Filter by Form**: Filter By Form is a filtering tool that allows you to locate records based on specified criteria. The user uses a form to enter search criteria. The search criteria are entered by clicking a drop-down list beside the field name and selecting a search value. See Figure 20. ([Return to Skills List](#))

To use the Filter by Form tool, you can:

1. When viewing a form in Form view (or Datasheet view), click the Filter by Form button located on the Form View toolbar.

2. Click in the field that you want searched. For instance, Figure 20 shows the Last Name field as the current search field. A drop-down list arrow will appear.

3. Click the drop-down list arrow, and select the value that should serve as the search criterion.

4. Click the Apply Filter button located on the Form View toolbar. The results should now display. If you are in Form view, you can scroll through the results by using the navigation buttons.

5. To remove the filter, you can press the Remove Filter button located on the Form View toolbar.

---

**Figure 20: Filter by Form Example**

Screenshots © Microsoft Corporation. All rights reserved. Copyright © 2005 by Prentice-Hall, Inc., All rights reserved.
**Find Unmatched Query Wizard:** The Find Unmatched Query Wizard locates records in one table that do not have a matching record or records in a second table. (Return to Skills List)

To use the Unmatched Query Wizard, you can:

1. Click the Queries button on the Objects bar located in the Database window.
2. Click the New button on the Database Window toolbar.
3. In the New Query dialog box, select the Find Unmatched Query Wizard option. See Figure 21.
4. Through a series of Find Unmatched Query Wizard dialog boxes, specify the tables or queries that you want compared, designate a matching field, specify the fields that you want to see in the query results, and then name the query.

![New Query Dialog Box](image)

**Figure 21: New Query Dialog Box**

**Form Design:** As this term is used in MIS Cases: Decision Making with Application Software, Second Edition, form design means preparing user-friendly, professional-looking data entry forms. When designing a form, you have the option of using one of several form wizards or designing the form from scratch. (Return to Skills List)

**Form Wizard:** As Figure 22 shows, Microsoft Access provides several types of form wizards. Through a series of dialog boxes, a form wizard asks you a series of questions about the new form's contents and appearance. The form wizard uses your answers to design a form. Once the form is designed, you have the option of modifying the form's contents and appearance. (Return to Skills List)
**IFF Function**: The Immediate IF function evaluates a condition as either true or false. The syntax for the Immediate IF function is:

```
=IIF(condition, value_if_true, value_if_false).
```

(Return to Skills List)

**Label Wizard**: The Label Wizard is a report wizard that creates mailing labels for you. (Return to Skills List)

To access the Label Wizard, you can:

1. In the Database window, click the Reports button located on the Objects bar.
2. Click the New button on the Database Window toolbar.
3. From the New Report dialog box, select the Label Wizard option. The Label Wizard asks you a series of questions, and based on your answers, prepares a set of mailing labels for you. The Label Wizard asks you to specify the table or query where the data are located, a label size, font and color, fields, sort field, and a name. Figure 23 provides an example of mailing labels generated by Microsoft Access's Label Wizard.
Figure 23: Mailing Labels Generated By the Label Wizard

**Lookup Wizard:** The Lookup Wizard creates a list of allowable values for a given field. Often, this list of values is based on field values from another table. The Lookup Wizard creates a combo box for the lookup field, enabling the user to select an appropriate value from a list. ([Return to Skills List](#))

To use the Lookup Wizard, you can:

1. When in the table's Design View, enter the name for the new field in the field name column.

2. For the new field's data type, click the drop-down list, and then select the Lookup Wizard option. See Figure 24. The Lookup Wizard dialog box now opens. Next, the Lookup Wizard asks you, through a series of dialog boxes, about how it is to obtain its values, the location of the list's values, the fields that contain the values that should appear in the list, sort order, the width of the columns, and a name for the list.
Macro: A macro is a group of automated instructions. When the macro is executed, Microsoft Access performs these instructions for you. For instance, you may want Microsoft Access to print a record or report, open a form or report, find a record, move data between tables, or exit Access. Macros provide you with the ability to custom design procedures for your database. Keep in mind that you can also create macro groups. You should use your system’s online help feature to investigate macros.

Macro Example: Assume a macro is needed to open the frmDepartment form.

To create a macro, you can:

1. While in the Database window, click the Macros button on the Objects bar.

2. Click the new button on the Database Window toolbar. The Macro Window now opens. See Figure 25.

3. In the Action column, click the drop-down list arrow beside the first empty box, and then select the appropriate action, such as OpenForm. Enter a descriptive comment in the Comment box.

4. In the Action Arguments pane, enter the arguments for the macro.
To create a macro to open this form, you can do the following:

1. Click the New button on the Database Window toolbar. The Macro Window now opens.

2. Click the first empty box in the Action column; click the drop-down arrow, and then select the OpenForm action.

3. In the Comments box, enter “Opens the frmDepartment form”.

4. Press F6. (This moves you to the Form Name box in the Action Arguments pane.)

5. Click the drop-down arrow, and then select frmDepartment.

6. In the View text box, make sure that Form is selected.

7. Save your macro.

---

To create a parameter query, you can:

1. Create a select query.
2. In the criteria row, enter a prompt message for the field for which the user should supply a value. The prompt message is contained in brackets. For instance, if the user should supply a department code, the prompt message would appear as [Please enter department code number]. See Figure 26.

![Figure 26: Parameter Query in Design View](image)

**Relationship:** A relationship is an association between two tables. Different types of relationships exist, such as one-to-one, one-to-many, and many-to-many. If you need to associate data in the Department table with data in the Position table, you should define a relationship between the two tables. To define a relationship between two tables, the two tables must have a common column. For instance, the Department table has a DCode field, and the Position table has a DCode field too. (Keep in mind that the field names do need to be the same.) The two fields should have the same data type. At this point, you should review your system’s online help feature to learn more about relationships. ([Return to Skills List](#))

To define a relationship, you can:

1. While in the Database window, click the Relationships button located on the Database toolbar. The Relationships window should now open. See Figure 27.

2. If a table is missing from the Relationships window, click the Show Table button located on the Relationship toolbar. You can double click the table name to add it to the Relationships window.

3. Click the field name in the first table and drag the field name onto the corresponding field name in the second table. (In other words, you can click the
primary key in the first table and then drag the primary key field onto the foreign key in the second table.) The Edit Relationship dialog box appears. In the Edit Relationship dialog box, you can enforce referential integrity and specify the join type, as well as make other changes to the relationship.

Figure 27: Relationships Window

**Report Design:** As this term is used in *MIS Cases: Decision Making with Application Software, Second Edition*, report design means preparing user-friendly, professional-looking reports. When designing a report, you have the option of using one of several report wizards or designing the report from scratch. See Figure 28. ([Return to Skills List](#))

To design a report, you can:

1. In the Database window, select the Reports button located on the Objects bar.

2. Click the New button on the Database Window toolbar.

3. From the New Report dialog box, select either a wizard or select the Design View option.

4. Select the table or query on which to base the report. Click the OK button. (Note: If you use one of the report wizards, the chosen report wizard will ask you a series of questions about the report.)
Report Wizard: As Figure 28 shows, Microsoft Access provides several report wizards. Through a series of dialog boxes, a report wizard asks you a series of questions about the new report's contents and appearance. The report wizard will use the information that you provided to design the new report. Once the report is designed, you have the option of modifying the report's contents and appearance. (Return to Skills List)

Select Query: A select query retrieves data from one or more tables based on the criteria specified in the design grid's criteria row. See Figure 29. (Return to Skills List)

To create a select query, you can:

1. Click the Queries button located on the Objects bar in the Database window.

2. Click the New button located on the Database Window toolbar. The New Query dialog box appears.

3. At this point, choose the method for building the select query.

4. If you select the Design View option, the Query Design window opens.

5. Add the tables that are to be used in the query to the Query Design window.

6. To add a field name to the design grid, double click its name in the field list.

7. In the criteria row, enter the selection criteria. For instance, to show only the filled position records for the Information Systems Department, you would enter "Information Systems" in the criteria row in the DName column and enter "Yes" in the criteria row in the Filled? column. See Figure 29.

8. Run the query, by clicking the Run button located on the Query Design toolbar.

Figure 28: New Report Dialog Box
**Subform:** A subform is contained on a main form. Often the main form will show a record from one table, and the subform will show related records from a second table. Microsoft Access provides several methods for including a subform as part of a main form. You should use your system's online help feature to learn more about subforms. Figure 30 shows a main form with a subform. One of the simplest ways to create a main form with a subform is to use the Form Wizard. (Return to Skills List)

To create a main form with a subform, you can:

1. Click the Forms button on the Objects bar located in the Database window.

2. Click the New button located on the Database Window toolbar.

3. In the New Form dialog box, select the Form Wizard, and then select the table that contains the fields for the main form. See Figure 31.

4. In the Form Wizard dialog box, select the fields that should appear on the main form. See Figure 32.

5. Before pressing the Next button, select the table that contains the fields for the subform. Select the fields for the subform. Click the Next button.

Screenshots © Microsoft Corporation. All rights reserved.
Copyright © 2005 by Prentice-Hall, Inc., All rights reserved.
6. The Form Wizard will now ask you how the data should display. Select the form with subform option, and then click the Finish button. See Figure 33. The new form will appear in Form View.

7. Switch to Design view and make any necessary changes to the new form.

---

**Available Positions**

<table>
<thead>
<tr>
<th>Position Type</th>
<th>Filled?</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td></td>
<td>Needs basic knowledge of spreadsheets</td>
</tr>
<tr>
<td>G4</td>
<td></td>
<td>No experience is required</td>
</tr>
<tr>
<td>S3</td>
<td></td>
<td>Typing</td>
</tr>
</tbody>
</table>

Records: 1 of 3

---

**Figure 30: Main Form with Subform**

**Figure 31: New Form Dialog Box**
Figure 32: Form Wizard Table and Field Selection

Figure 33: Form Wizard View Selection
**Switchboard:** A switchboard provides a menu that a user uses to access various database objects, such as forms, tables, reports, and queries. Figure 34 shows a sample switchboard. (Return to Skills List)

To create a switchboard, you can:

1. While in the Database window, from the Tools menu located on the Menu Bar, select the Database Utilities option, and then select the Switchboard Manager option. See Figure 35.

2. Click the Yes button when asked if you would like to create a switchboard. The Switchboard Manager dialog box now appears. At this point, you can add switchboard pages and add items to the switchboards. See Figure 36.

![Switchboard Example](image)

**Figure 34: Sample Switchboard**
**Tab Control:** A tab control is one method for placing a subform on a form. Figure 37 demonstrates the use of a tab control. Notice that the tab control has two pages, a Student Positions page and a Faculty Positions page. (Return to Skills List)

To include a tab control on a form, you can:
1. While in the design view for the main form, click the Tab Control button located on the Toolbox toolbar. Move back to the main form and size the control. See Figure 38.

2. Resize the main form so that you can also see the Database window.

3. Locate the form that you wish to use as the subform on your main form. Drag the form from the Database window onto the newly created tab control.

4. At this point, you will need to reposition the subform’s placement on the tab control page.

5. Double click the tab control page’s tab. When the property dialog box opens, change the name property.

Figure 37: Tab Control Example
Table Design: As this term is used in MIS Cases: Decision Making With Application Software, Second Edition, table design refers to the process of creating tables. Keep in mind that the process of identifying which tables to create and which fields to include in the tables is a more detailed process and covered in database management courses.

To create a table, you can:

1. Click the Tables button located on the Objects bar in the Database window.

2. Click the New button on the Database Window toolbar.

3. In the New Table dialog box, select the Design View option. The new table’s design view now appears.

4. For each field, you can specify its name, data type, description, and properties. You should select one field to serve as the primary key. Figure 39 shows the table design view.
Update Query: An update query makes global changes to a field or fields. For instance, assume that hourly wages paid to student workers will increase by 10 percent. You can create an update query to update the hourly wage field values. Keep in mind that the update query results cannot be reversed! See Figure 40. (Return to Skills List)

To create an update query, you can:

1. Click the Queries button on the Objects bar located in the Database window.
2. Click the New button located on the Database Window toolbar.
3. Select the Design view option from the New Query dialog box. The query design view appears.
4. Add the table or tables that contain the fields that you want updated.
5. Add the fields that should be updated to the design grid.
6. From the Query menu located on the Menu bar, select the Update Query option.
7. In the Update To row in the design grid, enter the expression that the update query should use to update the field's values.
8. Run the query.
Figure 40: Update Query in Design View